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Preface

This note describes RootView, a program for computer-aided measurement of plant roots. It also
includes a reference manual to the commands available in the program, and gives some hints on
how to capture the images needed as input, and how to most effectively process the data output
files.

RootView is mainly intended for measurement of roots in images obtained from minirhi-
zotrons, but could also be used for images obtained from rhizotrons, and “microcosms” (as used
in studies of mychorrhizas). It is used for tracing, measuring and classifying roots and tips. It
generatesraw data which can be used to calculate not only average root length and diameters,
but can also be used for studying the demography of fine roots.

RootView runs on PC compatible computers with Pentium family processors running WIN32
operating systems: Windows 95, Windows 98, and Windows NT 4.0.

RootView was developed for The Finnish Forest Research Institute (METLA), Joensuu Re-
search Station.

We think this program fills a gap in the tools available to researchers studying the eco-
physiology of roots by non-destructive methods. Any comments and bug reports are welcome.
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1 Overview

1.1 Introduction

In contrast to what happens with above-ground plant parts, roots are difficult to study because
they are included in the soil, a non-transparent medium. Different devices are in use to observe
roots in situ: rhizotrons (below-ground tunnels or similar constructions with windows to the
soil), minirhizotrons (tubes of a clear material such as glass or plastic) normally used to observe
roots with borescopes or special video cameras, and pots or containers with clear or removable
walls. All these devices provide two dimensional views of roots in the soil.

RootView is designed expressly for working with images from minirhizotrons to study the
growth and demography of fine roots and mycorrhizas. At Joensuu, we take images through the
wall of 54 mm inner diameter / 60 mm outer diameter acrylic tubes (or “minirhizotrons”) with
a special colour video camera. We use RootView to interactively measure roots as seen on two
dimensional images obtained by digitizing the PAL colour video signal. We currently capture
digital images with a Snappy device (Play Incorporated, distributed by Logitech) connected to
the printer port of a portable computer. The Snappy frame grabber is capable of video-frame
interpolation, and resolutions of more than 1024× 1280. Due to the quality of the analogue video
signal output by the video camera we use (BTC-100X, Bartz Technology Co., Santa Barbara,
CA, USA.) it is not worthwhile using resolutions higher than 800× 600 as the video camera has
a CCD with resolution of 752× 582 pixels. In some cases lower resolutions may be worth using
to save disk space. JPEG file format is used, as compression reduces file size considerably.

We take pictures on successive dates (several weeks apart) at the same location, using a
mechanical indexing handle to relocate the camera. Small registration errors occur. The size
of the field of view is 18 mm× 13.5 mm. For example, to cover a 18 mm wide band along a
0.70 m long tube requires 52 images. In a small experiment one can have 80 such tubes. So, at
each observation date one gets around 4 000 image files. Consequently, there can be as many as
16 000 images in a growing season.

RootView is a tool for computer-aided root measurement, not for automatic root measure-
ment. RootView makes the work of an operator more efficient and faster. There already exists
an MS-DOS program called ROOTS, functionally similar to RootView, but which requires the
use of a specific frame grabber card. It is designed for analysing images stored on video tape and
is available from Michigan State University. There is also a program for Mac computers called
RooTracker, written with hypercard.

In Sweden, automatic analysis of root images takenin situ through flat glass windows on
a below ground tunnel has been attempted using the image processing software system Khoros

9



1 Overview

Figure 1.1: RootView displaying an annotated image: the tracings on roots classified as belong-
ing to different categories are displayed in different colours. The root labelledR2 is
selected, and the nodes of the traced line are also displayed.

(Khoral Research, Albuquerque, NM, USA. In the USA a special program for automatic root
measurement in minirhizotron images has been developed (MR-RIPL 2.0, from the Root Image
Processing Lab, Michigan State University). These attempts at automatic image analysis and
measurement of roots had moderate success for white roots on black soil. Worse results should
be expected when colour and brightness differences are small between background and roots.

1.2 Implementation

1.2.1 The user interface

RootView is a WIN-32 (Windows 95/98/NT) program (Fig. 1.1). It is based on the idea of having
anexperimentas the basis for organizing the data. Each experiment is described in aproject file,
images are organized in directories or folders, and the ‘tracings’ and annotations are stored in a
text file for each image file. Finally the program generates, on request, an output file with data
about each root. This last file is in a format easy to import into Excel or other worksheet or
statistical programs, and also easy to parse with any custom written program.

Images are not modified by the program, so no images need to be saved. Saving of data files
is automatic, and a backup copy of last previously saved data is kept. As it is not possible to print

10



1.2 Implementation

plot tube frame date root category a length width
Peat Side 02 1998-05 R1 long 0 7.99 0.38
Peat Side 02 1998-05 R2 long 0 11.62 0.29
Peat Side 02 1998-05 R3 short 0 5.08 0.27
Peat Side 02 1998-05 R4 long 0 3.32 0.25
Peat Side 02 1998-05 R5 short 0 1.14 0.21
Peat Side 02 1998-05 R6 short 0 1.04 0.34
Peat Side 02 1998-05 R7 long 0 2.74 *

Figure 1.2: The first few lines of an output file

the images with RootView, another program such as Photoshop should be used.
RootView has a graphical user interface (GUI) with menus, toolbar, keyboard shortcuts, and

uses the mouse as input device for tracing (drawing) roots. It has on-line Help which can be
accessed from a menu, and context sensitive Help exists for the different dialogue boxes.

Only one image is displayed at a time, but it is easy to navigate through a sequence of images
taken at different times at a given location on a tube. It is also very easy to move from frame to
frame along a tube. It is also possible to move randomly to any other image in the experiment.

1.2.2 Data

The data about date, plot number, and tube number is described in the project file (.rvp) and
reflected in the directory structure used to store the files. The name of the files is not unique, but
the location in the directory tree identifies the images (.jpg ) and data (.rvd ) files. Image and
data files have a name which reflects theframenumber or location along the tube. The data file
is a text file where a user comment and data about the roots is stored. The data includes a list of
root objects, each one with an ID, a category label, and a list of co-ordinates defining the straight
line segments, a width, and a flag indicating whether the root is alive, dead or has disappeared.
Data about root tips (coordinates, category, andlife flag) is also stored.

IDs of objects are generated automatically and are consistent between successive images at
the same location (images should always be analysed in chronological order from oldest to most
recent).

Measurement data uses real world co-ordinates (in mm) rather than pixels. It is possible to
measure within one time series images stored at different resolutions.

The output file summarises the data in the whole experiment, or part of it —e.g. one plot.
It is a ‘rectangular’ text file, with data organized in columns and rows. The column separators,
missing-data marker, and column headings are all user customizable (Fig. 1.2).

1.2.3 Measurement procedure

Normally, measurement by tracing is performed sequentially through all images taken at a given
location. However, it is possible to continue from where analysis was stopped; for example, after
adding more images to the sequence (i.e. once data for a new measuring date is added).

11



1 Overview

5 Measurements
1998-05
1998-06
1998-07
1998-09
1998-11

2 Plots

Plot_01
2 Tubes

Side
1 34 18.00 13.50 First frame Last frame Width and Height

Up
1 34 18.00 13.50 First frame Last frame Width and Height

Plot_02
2 Tubes

Side
1 34 18.00 13.50 First frame Last frame Width and Height

Up
1 34 18.00 13.50 First frame Last frame Width and Height

__________________________________________________________________

Figure 1.3: The project file for a very simple experiment. Spaces are shown as.

Project set-up

1. The operator writes a project file (Fig. 1.3) using a text editor such as Notepad. The file
includes data on measuring dates, number of plots, number of tubes per plot, first and last
frame in each tube, and frame dimensions (in real world units such as millimetres).

2. The operator opens the project file with RootView, and accepts the prompt to generate the
directory tree for the experiment.

3. The operator uses RootView to define the categories which will be used to classify roots
and tips, choosing also the colours used to display the objects of each category. Categories
can be renamed or added at any later time. Categories can be safely deleted only if they
are not in use for any objects.

4. The operator does one of:

a) Moves already available files to the correct location in the directory tree, if necessary
renaming them with a file name which is the number of the frame along the tube (the
number of digits to use is user selectable).

b) Captures the images directly into the right directory.

12



1.2 Implementation

First image

1. The user selects a plot and tube to work on.

2. The first image at the given position is displayed. Date, plot, tube number, are extracted
from file name and directory. The operator can add a comment.

3. The operator traces roots and tips on the image, and assigns them to categories. RootView
displays the image with the traced ‘objects’ and their labels as an overlay (Fig. 1.1).

Later images

1. The operator requests the next image in the series. The image is displayed on the screen.

2. The objects traced on the previous image in the time series for the current frame areim-
portedand displayed as an overlay on the current image.

3. The user then adjusts registration taking a given feature of the image as reference, and
dragging the marker into place.

4. The objects are edited by the operator using the mouse: objects are modified (roots which
have grown), objects are added (new roots), objects arekilled (dead roots), objects are
changed from one category to another (e.g. white to brown), width is also changed if
necessary.

5. Go to 1 until all images are done.
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2 Manual

2.1 Introduction

In addition to this manual, information on how to use RootView is available in its help files
accessed through theHelp menu, and through Help buttons in dialog boxes.

In the sections below the procedures for project setup (page 15), image display and mea-
surement of roots (page 17), data output (page 23), installation of add-on tools (page 23) and
initial installation of the software (page 26) are explained. The hardware and software require-
ments are listed in page 26. Also some suggestions regarding the quality of images and general
experimental procedures are given in page 25.

The following typographical conventions are used:filename.tag , Menu > Submenu,
Key . The contents of ASCII text files are set intypewriter font.

2.2 The project and other configuration settings

2.2.1 The project file

In order to navigate through the large number of images belonging to one experiment, RootView
needs a description of the physical and temporal structure of the experiment. This information
is extracted from a RootViewproject file(*.rvp ) and it is only after successfully reading this
file that RootView becomes operational. The project file has an ASCII format and it can be
maintained and created with any ASCII editor (eg. Notepad or WinEdt).

The layout of the project file is simple. Data consists of two parts: measurements and layout
(Fig. 1.3). It must start with a line containing a (non-zero) number of measurements followed by
the “names” of measurements (which are usually dates and are used as names for folders inside
which data for each measurement is stored).

In the beginning one can start with just the first measurement and later add the new ones as
they become available for processing and analysis. RootView helps you create, and later expand,
the directory tree and monitors which data needs processing...

The list of measurements is followed by an empty line and then the second part of data
describing the experiment’s layout (Fig. 1.3).

Each Plot name (e.g. “plot01”) must be preceded by exactly one empty line, and followed
by a line indicating the number of minirhizotrons or tubes1 (e.g. “2 Tubes”). In contrast, there

1More accurately any strip of adjacent images, for example each row of images taken along one angular position of
a tube. If images are taken for example on right and left sides of a tube, for the purpose of processing they should

15



2 Manual

should be no empty lines between the tube descriptions. However,tube namescan be indented.
Each tube description contains data giving the dimension of the visual field encompassed by the
images and the index number for the first and last frames along the tube.

Copy and paste can be used to prepare such data fast. Just make sure that there are no errors
(e.g. the number of plots and tubes, empty lines and such). Text following the numbers is ignored
by the program, and can be used for comments.

There are no limits on the number of frames (all data in Root View is dynamic). For example,
one can specify:

100 999 18.00 13.50 A very long minirhizotron!

to indicate that the first frame in this tube has index 100 and the last one has index 999.
Names of Dates, Plots and Tubes can consist of any characters that are acceptable in file-

names (the Data Tree directories are named after them). However, it might be best to avoid
spaces in filenames as this can make interaction with other utilities and batch files more compli-
cated.

2.2.2 Names and location of image files

Image files should have as their name the index number of the frame, and a tag indicating the
file format; for example,01.jpg . Leading zeroes in frame names are not really necessary2. In
File > Preferences > Labels there is a field labelled “Frame Name”. In this field it is possible to
enter strings like 1, 01, 001, 0001, etc... to get the index expanded with no leading zeroes or one
or more when an image file is fetched. The decision of how many leading zeroes are used should
be made before the “jpeg” files are imported or annotated since it affects the filename convention
for .jpg and.rvd files.

RootView assumes that data is organized in the directory tree as follows:

<project root>\<date>\<plot>\<tube>\<frame number>.jpg

where<project root> is the location of the.rvp project file. RootView’s data browser
has a command to create, and later expand, the directory tree and let you know how many images
are present/missing and how many have been processed (a corresponding.rvd file exists).

2.2.3 Other configuration data

All other options are set through RootView, and are stored in two special files:RootView.ini
and RootView.cat . The first file contains the values pertaining to general preferences
(colours, labels and other settings accessible throughFile > Preferences). The second file con-
tains the list of Root and Tip Categories and their attributes (File > Categories). By default
RootView opens the files that are located in its base directory. However, if you make a copy of
any (or both) of the above files to the directory where your RootView project (*.rvp ) is located

be described astwo tubes.
2The advantage of having file names with leading zeros is that when sorted in alphabetical order they become sorted

in numerical order as well. This is handy when using Windows Explorer to look at the contents of directories.

16



2.3 Viewing, tracing and measuring roots

Figure 2.1: File and configuration commands in theFile menu.

these files and the settings inside them become local to the project and RootView loads the local
files after the project file is loaded. This makes it possible to work on more than one project.
You should not attempt to modify these files directly (with an Editor): always use theFile >

Preferences andFile > Categories dialogs to manipulate the values of data inside these files.
Categories to be used in the classification of roots and tips are set in theCategoriesdialog,

accessed asFile > Categories (Fig. 2.1). A few default categories are pre-defined, but the use of
category definitions local to the current project is highly recommended (see above). Categories
can be given almost arbitrary names, assigned a short-cut key, a display colour and line thickness.
Categories can be later renamed3 or even deleted if not used. New categories can be added later
as needed.

Preferences related to the behaviour of RootView are set in thePreferencesdialog, accessed
asFile > Preferences (Fig. 2.1). Preferenceshas several tabs. In theFonts and Colorstab, the
font used for displaying root labels is selected, and the colour palette can be edited. In theLabels
tab, the prefixes used for automatic generation of root and tip labels can be set. The colour used
for displaying labels is also set in this tab, as well as the format used for the image file names, as
described above in section 2.2.2. In theOptionstab, colours used to display nodes and the mag-
nification used for zooming steps, and maximum4 and minimum magnifications allowed when
zooming are set. TheOptionstab is used to set how the program behaves on start-up. Finally
theConfigurationtab displays the location of theRootView.ini andRootView.cat files
in use, as well as the base directory. (The name of the project file in use is displayed at the top
of the main window.)

2.3 Viewing, tracing and measuring roots

2.3.1 Choosing an experiment

After creating a RootView project file, start RootView and open the project file of the experiment
you want to start working on. The project file can opened by usingFile > Open... command.

3If a category is renamed, then all*.rvd files need to be scanned and fixed, so although RootView handles this
more or less automatically, it can be a very time consuming operation in a large experiment.

4Do not increase the maximum magnification allowed unless the PC has lots of RAM.

17
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Figure 2.2: Commands in theData menu.

Alternatively, you can drag and drop a project file into RootView’s Icon or a running instance of
the program. RootView also allows you to associate*.rvp files with its executable and thus
you can open such files by double-clicking on them in Windows Explorer. Once the project file
has been successfully loaded, RootView is ready to start working on the project’s images and
data.

2.3.2 Navigating through data

RootView displays in its status line Measurement, Plot, Tube and Frame name for the currently
selected and displayed image. Furthermore, the status line panels containing this information
respond to mouse clicks by displaying thedata browserwhich allows the selection of an arbitrary
frame to work on. Thedata browseralso provides a command to create the directory tree needed
to accommodate the data for the current project. This dialog also provides a command to scan
all data and display the information on the number of required, present and processed images.
Back and Next buttons in thedata browserare used to move through the project’s data tree: date
→ plot→ tube→ frame. Double-clicking on any item moves forward as well.

Navigating though consecutive measurements and frames in the same tube can be done di-
rectly with special commands, shortcuts and tool bar buttons (Fig. 2.2).

2.3.3 Tracing roots

Image editor

Root View’s Editor has two modes:adjusting registration error andobject editing. The ob-
jects are the tracings which represent roots and tips. The mode can be toggled by clicking the
leftmost tool bar button or by using theInsert key or withEdit > Toggle Edit Mode. The current
mode of the editor is shown by the corresponding toolbar button: depressed indicates registration
adjustment mode.

18



2.3 Viewing, tracing and measuring roots

Figure 2.3: Commands in theEdit menu.

Error registration

Error Registration is typically adjusted after a tracing has beenimported from the image from
the previous measurement (date). When you enter this mode a marker (Cross hairs) is displayed.
This marker can be positioned on any recognizable feature of the first image and can be later used
to properly adjust the error after the tracing is imported into the next measurement. Normally
this marker will be positioned on the image from the first measurement, but if needed it can be
relocated later. The marker is there to make the adjustment easier, but in many cases the tracing
itself provides enough reference points to achieve the adjustment.

To Position the marker (without moving the image) do the following: Press and hold the
Ctrl key and click anywhere in the image where you want the marker to appear and possibly

adjust its position by dragging it around (always holding theCtrl key). For extra precision you
can zoom in.

To register the error simply drag the image around (until the marker matches the image
feature used as reference point). The cursor changes its shape while you are adjusting the error
and the status line displays the actual error (compared to the image for the first measurement).

Object editor

A new Object (Root or Tip) is inserted in the image by holding theCtrl key while clicking on
its position. The Properties dialog is displayed allowing you to enter object’s attributes. If the
object is a root, you’ll typically continue byShift +Clicks to enter its nodes. The label initially
positions itself in the “centre of gravity” but you can later drag it to the position where it does
not obscure the view.

When tracing a series of similar Roots or Tips, displaying the dialog is an unnecessary dis-
traction. To quickly insert a new object (with the same Category as the last inserted one) the
operator can useShift + Ctrl qualifier while clicking on a new object. To speed up the pro-
cess even further, RootView allows each category to be assigned a shortcut key. Clicking with
the mouse while holding down a shortcut key inserts an object (Root or Tip) belonging to the

19
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associated category5.

The generation ofobject namesshould be normally left to RootView in order to ensure
consistent annotation from measurement to measurement. As the labels generated automatically
can be customised inFile > Preferences there should be no need to manually edit labels.

Clicking on any object (or its label) selects the whole object. A selected root displays its
nodes. Clicking on a node of a selected root tracing selects the node. Pressing theEsc key, or
clicking the right mouse button, or clicking on an empty spot de-selects any selected object.

Labels, nodes and tips can be dragged around. A Selected object can also be deleted (Toolbar
button orEdit > Delete). New nodes can be added to a selected root tracing usingShift +Click.
If a node is added outside the current tracing, then it is appended to the growing end (marked as
a square node). If a node is added on top of the old tracing the new node is inserted in between
the two adjoining nodes. The Backspace command deletes the last node at the tip.

If a node is selected thenDeleteremoves just the selected node rather than the whole root
tracing. A selected node can also be dragged to follow growth of a root. Colors of selected nodes
(and other objects) can be adjusted through thePreferencesdialog (see section 2.2.3, page 16).

Finally, each root has an attributeaverage width. The operator should spot the “typical”
position which reflects the average root’s width and mark the width at this position. This is done
by selecting the root, pressing and holding theAlt key, clicking on one edge of the root and then
dragging the mouse to the other edge (thus creating a visible width mark). For this procedure
zooming in might be useful.

There are two commands which can be used for removing objects from an image; however,
their purpose is different.Deleteis used to correct mistakes while tracing a root, andKill is used
to mark a root or tip as dead. Delete removes the object from the data file, while Kill marks it
as dead or gone. Consequently, objects which have been imported or exported between frames
shouldnot be deleted. Instead, such objects should be marked as “dead” using theKill command
or in the case when they disappear they should be marked as “gone” (Kill them twice). Dead
objects are still visible (roots use dashed lines) while gone objects do not appear in the image.
They remain in the data marked as gone. If the operator would (for some reason) like to see such
objects he or she has to toggle the value of the “Show Ghost Roots & Tips” button in the Tool
Bar.

Double clicking on any object brings theObject Propertiesdialog, which can be used to
change the category assigned to an object, its life status or to add a text comment. In theObject
Propertiesdialog the operator can explicitly change the 3-state life attribute by checking one of
the radio buttons (Alive, Dead, Gone).

Double-Clicking on an empty spot brings up theFrame PropertiesDialog. The only input
field in this dialog is for comments, but it displays information about the size of the image and
registration error.

Undoing is limited to the last change. Undoing twice redoes the change. This is enough to
restore accidental deletions.

5After some practice an operator might consider taking advantage of this functionality in order to speed up the
process of annotating images.
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2.3 Viewing, tracing and measuring roots

Figure 2.4: Commands in theView menu.

Save, restore and clear

The data are automatically saved to the corresponding*.rvd file when a new image is loaded
and displayed. A backup file is created with the data current when the data was last saved.File >
Save can be used to manually force a save and create a backup. The data in the backup file can
be made current withEdit > Restore, with all later changes lost.Edit > Clear deletes all current
data for the image displayed, but not the backup.Undocan be used to undo a restore or a clear.

2.3.4 Image display

Zooming

View > Real Size displays the image at its native resolution (one pixel in the image file is dis-
played as one pixel on the computer screen).

View > Fit Image to Client stretches or shrinks the image so that it exactly fits in thecurrent
size of RootView’s main window. Aspect ratio is not preserved.

View > Zoom In andView > Zoom Out increases and decreases the size of the image, respec-
tively. Aspect ratio is preserved. These commands can be used repeatedly, until the maximum
or minimum size is reached6.

Status line and toolbar

Root View displays the currently selected Measurement, Plot, Tube and Frame in its Status Line
(Fig. 2.5). Furthermore, the status line panels containing this informationrespond to mouse
clicks by displaying theData Browserdialog which allows you to directly select a frame to work
on.

TheData Browserdialog also provides a command to create the folders needed to accom-
modate data for the current project. Finally, the dialog provides a command to scan data and
display the information on the number of required, present and processed images.

The toolbar gives fast access to most frequently used commands. The icons in the toolbar
are the same ones as those in the menus (Fig. 2.6).

6How much the size of the image is changed each time a zooming command is applied, and the minimum and
maximum magnification limits, can be changed in thePreferencesdialog,Optionstab. (see section 2.2.3, page
16).
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a) Status bar with root R21 selected

b) Status bar with no objects selected

Figure 2.5: TheStatus line. Pressing the button with a question mark displays help about the
status line. The first four panels display measurement, plot, tube and frame for the
displayed image; the next two fields show the cursor position in pixels and in mil-
limetres; in edit mode the last pane a) with one root tracing selected, shows root
label, root length, root width and category, but b) with no objects selected, shows
image size in pixels, and image size in mm.
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Figure 2.6: Commands in the toolbar.
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2.4 Data output

2.4 Data output

Root View’s roots and tips data is “scattered” in the experiment’s tree directories in a format that
is not suitable for analysis and summaries. For this reason RootView is also able to generate
output files containing data summaries for all or part of an experiment. Separate output files are
generated for roots and tips. The user can choose to generate either output file or both.

Data output files are generated only at the operator’s request because gathering the data
from all traced roots in an experiment is a time consuming task.Data > Create Output or the
equivalent toolbar button opens theOutput Data Generatordialog, which is used to request the
generation of the file(s) from the data currently available in the*.rvd files. In theSelectiontab
of the dialog the user can choose to generate output files for the whole experiment or only for
certain plot(s) or measurement(s).

The Output file(s) have a rectangular shape (Fig. 1.2, page 11). The columns for roots data
look like this:

plot tube frame measurement root category a length width frame_area

and for tips:

plot tube frame measurement tip category a frame_area

The framearea column is optional, and not included by default as in most experiments all frames
have the same field of view. Attribute (labelled ‘a’ by default) is a special parameter which can
take one of three possible values: 0 foralive, 1 for deador 2 forgone.

The actual labels used for the headings of the columns can be specified in theOutput Data
Generatordialog as well. Columns are always aligned to the right. If insufficient width is
reserved by the length of a tag, the tag is automatically extended to accommodate the widest
item in its column. However, after that a warning is displayed and the data has to be generated
again. The changes to tags are saved for the next time if the dialog is exited through the OK
button. Keeping the columns as narrow as they could be can significantly reduce the size of the
output files. TheOutput Data Generatordialog also allows the operator to specify the column
separator (usually a space or a comma followed by a space), and the missing data marker (usually
‘*’ or ‘.’).

The output data files are always placed in the same folder as the project file. However, their
filenames can be chosen by the user. Since the program has to scan potentially a large number of
*.rvd files to produce a long output file (e.g. 100K lines), a progress indicator has been added to
the dialog.

2.5 Adding tools

2.5.1 Basics and special variables

TheTools Menu Setupdialog is used to configure the contents of the Tools Menu. Items in this
menu usually refer to applications that are used as add-ons in RootView, providing additional
functionality (e.g. moving the JPEG files or analyzing the output data).
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variable function example
%B Root View’s Base Directory
%P Project’s Base Directory
%F Project’s (*.rvp ) filename Experiment
%R Roots Output Data filename with tagRoots.dat
%r Roots Output Data filename only Roots
%T Tips Output Data filename with tag Tips.dat
%t Tips Output Data filename only Tips
%p location of currently selected image%P\Measuremet\Plot\Tube
%f Currently selected frame 01 ..n
˜ modifier, use short (8+3) filename %˜B, %˜P
/ modifier, use UNIX path style %/B, \%/P

Table 2.1: Special variables available in theTools Menu Setupdialog.

The definition of an Item consists of its menu name and the command line. Special param-
eters such as %P, %F can be used to pass values depending on the current project and selected
frame to the accessory in its command line. If the check-box in front of the Item is checked
then a special dialog displaying the exact command line that is about to be executed is displayed
before the application is launched. Specifying a non-emptyCaption instructs RootView not to
execute the command line if the application with the specified caption is already running. The
running instance gets in the foreground, instead. It is also possible to specify the initial directory
for the application that is to be activated. Defining anItemas “-” (without quotes) is interpreted
as a menu separator rather than a command.

RootView’s intended functionality is limited to: navigating through an experiment’s images,
tracing roots and tips on the images and storing and displaying these tracings (Image Editor),
and generating output (raw) data files.

Tools for capturing images, moving the JPEG files to RootView’s project directory tree,
performing data analysis and producing summaries is/will be implemented separately. However,
RootView can act as a front end and application launcher for this purpose. ItsTools menu can be
customized to include such add-ons.

Launching an application or a batch file would not be of much use unless Root View could
also provide parameters pertaining to the current project and data files. For this purpose special
% variables have been introduced (Table 2.1).

Example: A menu item that opens the project file in Notepad can be defined as:
notepad.exe "%P\%F.rvp" . Frequently used applications can be assigned a shortcut and
can thus be quickly activated from within Root View...

2.5.2 Examples

These examples (Table 2.2) assume that the commands refer to executables accessible through
the PATH environment variable. If that is not the case the whole path should be included instead
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Item Command Startup Folder
&Edit Project File notepad.exe "%P\%F.rvp"
&Capture Images snappy.exe %p
&Archive data WZzip.exe -u -o -yp -r -p "%P\%F.zip" "*.rvd" %P
&Add measurement perl.exe %B\perl\add_meas.pl "%P\%F.rvp" %P

Table 2.2: Examples of item definitions for theTools menu.

of just file name. Notepad.exe is included with Windows, Snappy, Winzip and Perl should be
installed separately.

2.6 Tricks-of-the-trade

2.6.1 Image quality

It is extremely important to get sharp images, so focusing should be done with great care on a
good monitor. It is important also to minimize registration errors by careful set up of the camera,
and especially by using a correctly sized drill bit for the index holes in the minirhizotron tubes.
Cleanliness is also very important to avoid scratches in the walls of the minirhizotrons as this
also degrades image quality.

For capturing images, we recommend the use of a resolution similar to the resolution of the
video camera, but in some cases the use of lower resolutions may speed-up image capture and
reduce storage space at the cost of lower precision (more guessing) in the measurements.

RootView reads images in JPEG format. This format usually uses lossy compression; in
other words, the file is compressed in such a way that not all the information is recovered during
decompression. This is not a big issue as long as not too much important detail is lost. When
creating JPEG it is possible to choose the degree of compression used. There is always a trade-
off between size after compression and image quality. It is best to use the medium to high quality
range when capturing images.

RootView can work with JPEG images from any source, although we currently use a Snappy
still video capture device. This device has the advantage of grabbing images of the highest
possible quality for a given analogue video source; however, it is rather slow. The Snappy device
does frame interpolation; in other words, it uses information from several frames of the analogue
video to synthesize a single high resolution digital still image. It is important to use the right
settings in Snappy for the video source in use. In our case: signal from a video camera (as
opposed to broadcast signal) and still subject (as opposed to a moving subject).

2.6.2 Calculating summary statistics

Importing into Excel. Importing into SPSS. Using Perl or AWK.
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2.6.3 Murphy’s Law

Finally we strongly recommend making regular back-ups of image and data files, and keeping
them in a safe place. There is too much time and effort spent in this kind of experiments to have
them ruined by a failure in a PC or a human error.

2.7 Hardware and software limits

RootView is written in Delphi 4 (Professional Edition). All data is dynamic — there is no
imposed constraint on the amount of data except for a computer’s resources and capabilities.

The program requires at least a Pentium 90, with 16 Mbytes of RAM, and an 800× 600
colour display, running WinNT 4.0/ Win98 or Win95. For smooth performance Pentium 166
with 32 MBytes (or better) is strongly recommended. Images consume the computer’s memory
very fast and some design decisions have been made in order to keep the program resource
friendly. In particular, only one image is loaded in the computer’s memory at each moment. A
good sharp colour monitor is also a must for precise work, and/or long working hours.

A RootView data file for each image uses 3-5 KBytes of hard drive space (twice as much
with the backup copy). This should not cause any problems even when the experiment consists
of 10K+ images. However, an average 600× 800 pixels colour JPEG file has a size of more
than 100 KBytes, so for a large experiment it might be necessary to remove the old JPEG files.
RootView is designed to function correctly even after the JPEG files for processed frames have
been removed: it is no longer possible to view or edit such images, but its objects (roots and tips)
can still be included in the output data generated by RootView as well as being imported into the
next measurement.

2.8 Installation

The program is delivered either as a compressed file (RootView.zip ) or as an uncompressed
directory structure on a CD-ROM.

Either...

• Extract the contents ofRootView.zip into a directory, for exampleC:\RootView ,
preserving the directory information stored in the archive. For extraction you will need
WinZip.

• Assuming your CD-ROM drive isD: , copyD:\RootView\ and all its contents to your
machine’s hard disk, for exampleC: .

Once the files are installed RootView can be started by clicking on the icon labelled
‘RootView’ or ‘RootView.exe’ in the installation directory (e.g.C:\RootView\ . However it is
recommended that you create a shortcut to RootView on your desktop by dragging the icon while
pressingAlt . (The ‘Target field’ should be for exampleC:\RootView\RootView.exe and
the ‘Start in’ fieldC:\RootView .)
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After RootView is installed, it is also convenient to associate.rvp “RootView project files”
with the RootView executable, so that they can be opened by double clicking on them in the
Windows Explorer. (You do this by choosingView > Options... > File Types and pressing the
‘New Type...’ button. For description of type put ‘RootView project’. For Associated extension
put ‘rvp’. For action ‘open’ putC:\RootView\RootView.exe as application, and make
sure that ‘Use DDE’ is not selected. See the Windows help for details.) It is suggested that the
Tools menu is customised to the utilities available.

To completely uninstall RootView simply delete theC:\RootView directory and all its
contents.
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